
uTech - Online Teaching and Learning Tipsheet 

Creating an Accessible Syllabus ​
In MS Word (Windows)​ 

 

Introduction 
All online course syllabi at Western Illinois University are required to meet accessibility guidelines.  

Essentially, this involves creating a document in a manner that allows individuals with assistive devices to 

navigate it in a logical order. This tip sheet provides step-by-step instructions on using the accessibility 

checker within Microsoft Word and step-by-step instructions for making your document accessible.  

​
Note:  OTL has created an accessible template and companion site for online syllabi. The companion 

Syllabus Template website offers exemplary paragraphs and wording to include in your online course 

syllabus.  
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I.​ Running the Accessibility Checker 

The accessibility checker helps you identify and correct accessibility issues within your 

document.  

a.​ Click Review on the Ribbon menu in the toolbar.​
​

 
 
 
 
 
 
 
 
 
 
 

b.​ Click on Check Accessibility, then choose Check Accessibility from the ​
drop-down menu.  

 
c.​ The Accessibility Checker pane​

will appear to the right of the document. It 
will show the inspection results. ​
 

d.​ Click on a specific issue within ​
the inspection results to select it. ​
 

e.​ At the bottom of Accessibility​
Checker Pane, you will see the ​
Why Fix? option that explains why you 
should fix the issue, and in the Steps to 
Fix option you will find steps that guide 
you on fixing the issue. ​
 
Follow the steps provided in the window 
to fix all identified issues, then run the 
accessibility checker again until all issues ​
are gone.  
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II.​ Adding Headings to your document 

Headings give documents a hierarchical structure that will allow assistive devices to successfully 

navigate your syllabus in a logical order. According to webaim.org, a page structure should follow the 

heading order shown below.  

•​ Title – serves a clear and concise description of the document, making it easier for the screen 

reader users to understand the document’s purpose. It is the first piece of information conveyed 

to the user when the document is opened. 

•​ Heading 1 – Main content heading.  This is the most important heading and there should be 

only one per document.  

•​ Heading 2 - major section heading.  

•​ Heading 3 - sub-section of a Heading 2 section.  

•​ Heading 4 - sub-section of a Heading 3, and so on through Heading 6.  

Using such a page structure allows users with assistive devices to view all headings on one page (table 

of contents), selectively choose which headings to visit, and read or navigate through the document by 

heading without having to read every word. Visit WebAim’s information on headings for a deeper 

understanding.  

 

Follow the steps below to add Headings to your document. ​
 

a.​ Select the most important heading within your document that you want to use as Heading 
1 (H1).​
 

b.​ Select the Home tab in the toolbar. ​
 

c.​ Click on Heading 1, to change your selected text into ​
a Heading 1 within your document. ​
 

d.​ Repeat steps a. - c. as you format the remaining headings throughout your document 
based on a hierarchical order (H2, H3, H4, etc.)  

 

  
 
 Remember, you can have as many H2, H3, H4 as necessary, but you can only have one H1 to identify 
your most important heading. 
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III.​ Providing alternative (alt.) text for images 

Alternative text should be added to images in order to provide a non-visual representation of the content 
or function of an image.  You should provide alternative text for all images contained in your document.   
​
The website webaim.org provides these best practices for alternative text:  
​
Alternative text should:  

●​ Be accurate and equivalent - present the same content or function as the image.  
●​ Be succinct - no more than a few words are necessary.  
●​ NOT be redundant - do not provide information that is in the surrounding text.  
●​ NOT use descriptive phrases - screen reading software identifies images, so it is not necessary to 

use phrases such as “image or. . .” or “graphic of. . . “  
 
Follow the steps below to add Alternative text to images in your document. ​
 

a.​ Right-click on the image that you 
would like to add Alternate text to, 
then select View Alt Text. . .  . 
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b.​ The Alt Text window will appear, and you 
will see a field where you can enter 
alternative text for your image along with 
guidance directly above the field. ​
 

c.​ Alternatively, if the image does not convey 
necessary information, you can select Mark 
as decorative.  (Note: if the image is 
needed for understanding you must 
provide alt text.   
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IV.​ Using tables 

Webaim.org states, “The purpose of data tables is to present information in a grid, or matrix, and to have 

columns or rows that show the meaning of the information in the grid. Sighted users scan a table to 

make associations between data in the table and their appropriate row and/or column headers. Screen 

reader users make these same associations with tables in web pages and PDF files. Unfortunately, 

support for table headers is limited in Word. You can add properties to Word documents so column 

headers (headers in the first row of the table) are identified by a screen reader and read and when 

exported to PDF. Unfortunately, row headers (headers in the first column of the table) do not have the 

same level of support.” 

 

The following tips will assist you in providing the most accessible form of tables possible in MS Word.  

•​ Do not use tabs or spaces as alternatives to creating tables.  

•​ Do not use tables for page layout purposes. They should only be used to present columns and 

rows of data.  

•​ Do not use the Draw tool to create tables.  

•​ Do add and repeat Row and Column Headers to distinguish between heading text and data.  

Follow these steps to add and repeat Row and Column Headers in Microsoft Word tables.   

 

a.​ Select the first row of the table (that contains your headers.)​
 

b.​ Right click on the table and choose Table Properties. ​
​
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​
​
 

c.​ Click on the Row tab. ​
 

d.​ Select Repeat as header row at the top of each page. ​
 

e.​ Click the OK button. 
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V.​ Create accessible hyperlinks 

Webaim.org states Hypertext links are one of the most basic links of HTML. Therefore, making hypertext 

links accessible is one of the most basic and most important aspects of web accessibility.  Typically, 

when creating a hyperlink in a Microsoft Word document we copy and paste the link into the document, 

resulting in the automatic creation of the link. This does not guarantee that a link is accessible.  In order 

to make a link accessible in Microsoft Word follow these tips and steps.  

​
Tips for creating descriptive, accessible links: ​
 

•​ Use descriptive link text that doesn’t require context from surrounding text. Link text should 

inform users where the link will take them.  

•​ Keep the amount of text in the link to a minimum.  

•​ Do not use terminology that is difficult to understand out of context. (e.g. don’t use something like 

“click here”.)  

•​ As a precaution include the URL where they are going to be directed to in parentheses after the 

hyperlink.  

​
Follow these steps to set descriptive link text.  

 

a.​ Type in a sentence in which the link falls in context, such as, “Please visit the Western 
Illinois University web page.” ​
 

b.​ Select (click and drag to highlight) the text that you want to turn into ​
a link (e.g. Western Illinois University). 
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c.​ Right-click (Ctrl + Click) on the text and choose Link.  
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d.​ The link text should already be placed in the Text to display field. If it is not correct or you 
would like to change it type new text into that field. ​
 

e.​ Copy and paste or type the URL where you want the link to take the user in the Address 
field. ​
 

f.​ Click the OK button.  
 
​
 

g.​ Additionally, you can add a screen tip that will appear when someone moves over the link 
to provide additional information. Click on the ScreenTip button.​
 

h.​ Enter descriptive information into the ScreenTip text field. ​
 

i.​ Click the OK button.  
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VI.​ Using Lists 

Webaim.org states, like Headings, lists convey a hierarchical content structure. Lists are used to separate 

important information from paragraphs and are very important to the structure of a document.  List 

structure should be used wherever a logical list is present, and nowhere else. You should never merely 

create something that looks like a list by starting each paragraph with a bullet character.   

 

Sometimes users create such lists by pressing the Tab key to indent content.  This provides a visual 

structure for the document.  However, it does not provide a suitable structure for assistive technology 

users.  In order to provide an accessible document, you need to follow the following best practices and 

use the list tools within Microsoft Word.  

 

Tips for using lists:  

•​ Lists should be used to represent information in a certain order.  

•​ Use Microsoft Word’s list tools rather than the tab key, hyphens, and asterisks.  

•​ There are two types of lists. Ordered (numbered) and unordered (bulleted). ​
Ordered lists present information in a particular order.  They should be used to convey direction 

or present information in a series of steps such as in a user manual or recipe.  This type of list 

should include at least two items.  Unordered lists also known as bulleted lists could include one 

or more items. They are typically used to separate important information from a paragraph or 

highlight key points.  

 

Follow these steps to create a list in Microsoft Word.​
 

a.​ Type in a list of items.  (Type a word and then 

press your return/enter key to enter the next, 

and so on.) Then click and drag to select 

(highlight) the text you want to include in your 

List. ​
 

 

 

 

 

 

 

​
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b.​ Click on the Home tab in the 

toolbar.​
 

c.​ Click on the Bulleted List ​
button in the toolbar. ​
 

d.​ Your bulleted list will be created. ​
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VII.​  Adding a table of contents 

For long documents, it is recommended that you supply an interactive table of contents.  Since you have 

created a hierarchically ordered document using headings, this will be quite simple.   

 

Follow these steps to add an interactive table of contents.  

a.​ Click where you want to insert 
the table of contents within your 
document. Usually, this will be 
near the top of the first page, 
then click the References tab 
on the toolbar. ​
 

b.​ Click the Table of Contents 
icon. ​
 

c.​ Click on the style of the table of 
contents you would like to use.​
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d.​ Your table of contents will appear in your document. 
​
There will be times when you make changes to your document and you will need to update the 
Table of Contents​
 
e.​ Click on the Table of Contents within your document to select it, then click on the Update 

Table tab to the upper left. When the pop-up menu appears, click Update entire table, then 
click Ok.​
 

f.​ If you decide to remove the table of contents from your document, click on the icon to the left 
of the Built-In window pane, choose Remove Table of Contents at the bottom of the pop-up 
menu. The table of contents will be removed. ​
​
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Note about Copying and Pasting Information 
into this Document 
If you intend to copy and paste information from your current syllabus into this document, use the Paste 

Special method under the Edit menu or by right-clicking in the document where you want to paste your 

content and choosing Unformatted Text to ensure that the fonts match.   

Resources 
•​ OTL Homepage 

•​ OTL Webinars and Self-Guided Training 

Accessibility Resources 

•​ WebAIM.Org MS Word Tutorial 

•​ WIU Accessibility Resources 
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